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RESUMO GERAL 

A utilização de microalgas imobilizadas em matrizes de alginato para a remediação de 

efluentes provenientes de sistemas de recirculação de água (RAS) tem se mostrado uma 

alternativa viável para sistemas aquícolas. A eficiência de algumas espécies de microalgas 

já foi testada; no entanto, a metodologia de produção das esferas ainda é um problema 

recorrente devido à competição com íons de sódio (Na+) presentes no efluente com o 

agente utilizado na reticulação das esferas (CaCl2). O presente estudo avaliou a 

otimização das esferas e a eficiência de Nannochloropsis oceanica na remoção de nitrato 

e fosfato de um efluente proveniente de RAS, bem como a realização de banhos reforço 

de CaCl2 durante o tempo de exposição das esferas ao meio. Os resultados mostraram que 

a microalga N. oceanica removeu os nutrientes do efluente, resultando em taxas de 

crescimento superior a células livres. O trabalho também demonstrou que a presença de 

microrganismos naturalmente presentes nesses efluentes comprometeu a estabilidade das 

esferas.  

Palavras-chave: Encapsulamento, esferas de alginato, microalgas, imobilização.  
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ABSTRACT GERAL 

The use of microalgae immobilized in alginate matrices for the remediation of effluents 

from recirculating water systems (RAS) has proven to be an ecologically viable 

alternative for aquaculture systems. The efficiency of some species of microalgae has 

already been tested; however, the methodology for producing the beads is still a recurring 

problem due to the competition with ions of sodium (Na+) present in the effluent with the 

agent used to cross-link the beads (CaCl2). The present study evaluated the optimization 

of the beads and the efficiency of Nannochloropsis oceanica in removing nitrate and 

phosphate from an effluent from RAS, as well as the use of CaCl2 booster baths during 

the exposure time of the beads to the medium. The results showed that the microalga N. 

oceanica removed nutrients from the effluent, resulting in higher growth rates than free 

cells. The work also showed that the presence of microorganisms naturally present in 

these effluents compromised the stability of the beads.  

Keywords: Encapsulation, alginate beads, microalgae, immobilization.  
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1. INTRODUÇÃO GERAL 

1.1. Aspecto mundial da Aquicultura 

A aquicultura desempenha um papel fundamental nas estratégias de segurança 

alimentar e nutrição da população mundial a longo prazo (Wang et al. 2015). Em 2020, a 

aquicultura foi responsável por 49% da produção mundial de pescado, o equivalente a 

US$ 265 bilhões (FAO, 2022). A expansão da aquicultura nas últimas décadas é 

consequência do aumento da demanda global por proteína animal, o que torna os sistemas 

intensivos mais adequados para atender a essas demandas (Little et al. 2016). No entanto, 

quanto mais intenso for o cultivo, maiores serão as concentrações de compostos 

nitrogenados, fosfatados e matéria orgânica em suspensão e dissolvida na água 

(Wasielesky et al. 2006; Krummenauer et al. 2012; Rurangwa e Verdegem, 2014; Ahmed 

e Turchini, 2021). 

 

1.2. Sistemas de Recirculação de Água 

Os sistemas de recirculação de água (RAS, Recirculating Aquaculture Systems) são 

sistemas intensivos de produção aquícola, que oferecem a vantagem de produzir em um 

ambiente controlado, com medidas de biossegurança aprimoradas e, que une a obtenção 

de cronogramas previsíveis e taxas de crescimento monitoradas com a redução de riscos 

relacionados a surtos e infestações de parasitas (Chen et al. 2018; Ahmed e Turchini, 

2021). Os RAS são sistemas ambientalmente sustentáveis pois permitem que 90-99% da 

água seja reciclada (Badiola et al. 2012). Isso faz com que esses sistemas sejam menos 

dependentes de água do que sistemas convencionais de aquicultura (Ebeling e Timmons, 

2012). Os sistemas RAS contam com fluxos de resíduos controláveis e, a maioria é 

operada com no máximo 5% de troca de água por dia (Ebeling e Timmons, 2012; Badiola 

et al. 2012; Murray et al. 2014). A baixa troca de água em RAS se deve às diferentes 

etapas de tratamento, como filtração, remoção da amônia e nitrito, reoxigenação e 

remoção de dióxido de carbono (Roalkvam et al. 2020).  

Contudo, os RAS podem apresentar algumas desvantagens, como o alto consumo de 

energia utilizado durante a operação, um considerável investimento para sua implantação 

(Ahmed e Turchini, 2021) e os nutrientes orgânicos e inorgânicos dissolvidos, 

remanescentes desses sistemas, que, geralmente são descartados com a água do efluente 

(Barak et al. 2003). A qualidade da água nesses sistemas pode ser afetada devido, 
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principalmente, ao acúmulo de metabólitos de peixes, como amônia e dióxido de carbono 

(Ebeling e Timmons 2012). 

 

1.3. Nitrato no sistema de RAS 

A amônia é a principal forma de nitrogênio excretada por animais aquáticos e pode ser 

encontrada tanto na forma gasosa (NH3) quanto em sua forma ionizada amônio (NH4
+) 

(Purwono et al. 2017). A oxidação da amônia durante o processo de nitrificação e a 

interação do dióxido de carbono com a água tendem a acidificar o ambiente pela liberação 

de íons de hidrogênio (Ebeling e Timmons, 2012). Os filtros biológicos realizam a 

oxidação da amônia por meio das bactérias nitrificantes autotróficas, através de processos 

de nitrificação que tem como produto final o nitrato (Hagopian e Riley, 1998). O processo 

de nitrificação aeróbica ocorre em duas etapas, onde a amônia (NH4
+) é oxidada a nitrito 

(NO2
-) que depois é oxidado a nitrato (NO3

-) (Ebeling e Timmons, 2012). Duas 

associações de bactérias trabalham coletivamente na nitrificação e no controle da amônia, 

as que oxidam a amônia e as que oxidam o nitrito (Beman et al. 2010; Ruiz, 2019). As 

Bactérias Oxidantes de Amônia (BOA) obtêm energia catabolizando a amônia não 

ionizada para nitrito (Sedlacek at al. 2016). A segunda etapa da nitrificação é realizada 

pelas Bactérias Oxidantes de Nitrito (BON), que geram energia a partir da oxidação de 

nitrito (NO2
-) em nitrato (NO3

-) (Daims et al. 2015; Van Kessel et al. 2015). 

Estudos relacionados aos efeitos tóxicos do nitrato em organismos aquáticos apontam 

principalmente para a metemoglobinemia (MetHb), ou seja, a oxidação da hemoglobina 

(Hb) no plasma (Wang et al. 2015; Monsees et al. 2017). Os efeitos tóxicos do nitrato 

reduziram os níveis de hemoglobina plasmática (Hb) em tilápias do Nilo (Oreochromis 

niloticus L.), linguado europeu (Scophthalmus maximus) e peixes-espada-pintados 

(Oplegnathus punctatus) (Monsees et al. 2017; Yang et al. 2019; Yu et al. 2021a; Yu et 

al. 2021b). Os autores Isaza et al. (2020), em uma meta-análise, constataram que em todos 

os estudos, os grupos taxonômicos (peixes, anfíbios e anfípodes) que tiveram em 

exposição ao nitrato, tiveram uma redução na taxa de sobrevivência de em média 62,50%, 

além de uma série de consequências subletais, incluindo comedimento do crescimento e 

maiores índices de má formação desenvolvimento. 

A remoção de nitrato de águas residuais pode ser obtida quando empregado o processo 

bacteriano de desnitrificação, onde o nitrato é reduzido a gás nitrogênio (N2) que é 
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inofensivo para os organismos (Klas et al. 2006). No entanto, esse é um procedimento 

custoso financeiramente e exige uma fonte de carbono orgânica como doadora de elétrons 

como metanol, acetato, lactato ou glicose (Ahn, 2006; Wang e Chu, 2016; Xia et al, 2020).  

No entanto, nas últimas décadas, a poluição por nitrato em recursos hídricos tornou-se 

um problema ambiental global, alvo de diversos estudos (Kazakis et al. 2020; Jiang et al. 

2021; Yu et al. 2022). 

 

1.4. Fosfato no sistema de RAS 

Outro importante nutriente encontrado no RAS em elevadas concentrações é o fósforo 

(P), principalmente devido ao excesso adicionado na formulação da ração e que acaba 

não sendo absorvido pelos peixes (Rodehutscord e Pfeffer, 1995; Coloso et al. 2003; 

Herath e Satoh, 2022). Ainda assim, o ciclo do fósforo em sistemas de recirculação de 

água é menos conhecido do que o ciclo do nitrogênio (Barak et al. 2003). O efluente da 

aquicultura comercial é composto por produtos de resíduos metabólicos com níveis 

potencialmente elevados de P (Coloso et al. 2003). O fósforo não digerido é excretado 

em forma de partículas nas fezes dos peixes, enquanto o P digerido em excesso, em 

relação as necessidades dos organismos, é metabolizado e excretado em forma de 

ortofosfato inorgânico (PO4
-P) na urina dos animais (Coloso et al. 2003; Lall e Kaushik, 

2021).  

 

1.5. Efeitos de N e P no ambiente 

O descarte regular de águas residuais sem tratamento adequado resulta em sérios 

desequilíbrios tróficos nos habitats marinhos e costeiros (Gil-Izquierdo et al. 2021). Um 

dos principais problemas associados ao descarte de efluentes em águas costeiras é o 

aumento do teor de nutrientes, sobretudo nitrogênio e fósforo, em um processo conhecido 

como eutrofização, que promove um crescimento significativo da vida vegetal aquática 

(Lam et al. 2020). Devido à baixa troca de água e a alta densidade de estocagem, os RAS 

podem produzir águas residuais até cem vezes mais concentradas que sistemas 

tradicionais (Martins et al. 2010). Nesse sentido, a eliminação ou a redução desses 

nutrientes se torna essencial para o uso de sistemas intensivos e superintensivos como em 

RAS (Sarkheil et al. 2021).  
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O uso de métodos alternativos no processo de remoção de nutrientes como fósforo e 

nitrogênio da água pode melhorar significativamente o desempenho do RAS (Sarkheil et 

al. 2021). Plantas aquáticas estão sendo estudadas como biossorventes de troca iônica 

para o tratamento de águas residuais (Huang et al. 2020). No que diz respeito a 

tecnologias baseadas em microalgas, diversos estudos contribuem para a conclusão de 

que esses organismos são uma alternativa promissora no tratamento do efluente 

proveniente da aquicultura (Han et al. 2019; Tom et al. 2021; Mahari et al. 2022). 

 

1.6. Microalgas 

As microalgas são organismos unicelulares, fotossintéticos, microscópicos, capazes de 

converter dióxido de carbono, luz, água, macro e micronutrientes em biomassa (Olaizola, 

2003; Caprara et al. 2023). Podem ser encontradas em ecossistemas marinhos e de água 

doce, tornando-se essenciais para o tratamento biológico de águas residuais, devido à sua 

capacidade de purificação e absorção do nitrogênio e o fósforo de origem antrópica (Chai 

et al. 2021).  

Em virtude da boa adaptabilidade ambiental e resistência, as espécies do gênero 

Nannochloropsis (Fig. 1) têm recebido cada vez mais atenção dos pesquisadores, o que é 

testemunhado por um aumento significativo no número de publicações em periódicos nos 

últimos anos, conforme relatado no trabalho de Ma et al. (2016). É um gênero de 

microalgas marinhas unicelulares, sem flagelo, pertencentes ao Filo Heterokontophyta, 

da Classe das Eustigmatophyaceae, família das Eustigmataceae, conhecidas por sua alta 

produtividade de biomassa fotoautotrófica, sua notável capacidade na acumulação de 

lipídios e o sucesso em cultivos de escala industrial (Radakovits et al. 2013). Esse gênero 

compreende seis espécies, com células de morfologia simples, com plastídios 

semelhantes aos das células vegetais e diâmetros que variam entre 2 e 8 μm (Hibberd et 

al. 1981). Atualmente, o gênero Nannochloropsis é utilizado como base alimentar no 

setor aquícola para o cultivo de peixes marinhos, moluscos e camarões, assim como para 

a produção de zooplâncton (Al-Hoqani et al. 2016; Camacho-Rodriguez et al. 2016). 
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Figura 1: Foto do cultivo em meio f/2 da microalga do gênero Nannochloropsis. 

Escala: 10μm. Retirado de: https://www.algaebase.org/ 

 

1.7. Alginato de sódio 

A imobilização de microalgas em gel pode ser uma forma sustentável de melhorar a 

qualidade da água e a produção de organismos aquáticos (Ramli et al. 2017). Devido à 

sua natureza não tóxica, transparente, permeável e hidrofílica, polímeros naturais são 

comumente utilizados na imobilização de microalgas para a ficorremediação de águas 

residuais, evitando que compostos como N e P sejam descarregados no meio ambiente 

(Emparan et al. 2019). Além da maior eficiência na remoção de nutrientes em comparação 

com células livres suspensas, as esferas de alginato são maiores que as células livres, 

permitindo que seja empregado um método de coleta simples e sem muita demanda de 

energia, como peneiramento (Moreno-Garrido, 2008; de-Bashan and Bashan, 2010). Esse 

método de cultivo se converte na produção de microalgas que podem ter inúmeras 

aplicabilidades (Zeng et al. 2013). 

O encapsulamento é o processo de confinamento de um composto ativo dentro de uma 

matriz polimérica na forma de partículas, visando imobilizar, proteger, estabilizar, liberar 

de forma controlada o composto ativo ou alterar as propriedades dos produtos (Chan et 

al. 2009; Chan, 2011). Dentre os polímeros naturais, o alginato de sódio é um dos mais 

amplamente utilizados para encapsulamento (Moreno-Garrido, 2008). Sendo um 

polissacarídeo natural derivado de algas marinhas marrons, apresentando duas estruturas 
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molecular composta de copolímeros lineares de ácido manurônico (ManA) e ácido 

gulurônico (GulA) (Lee et al. 2013). 

As cadeias poliméricas que constituem o alginato, variam entre as espécies de algas 

marinhas e suas propriedades físico-químicas podem ser significativamente afetadas pela 

abundância e/ou distribuição das unidades do bloco G (e.g.: GulA) e bloco M (e.g. ManA) 

(Rhein-Knudsen et al. 2017; Youssouf et al. 2017). A partir disto, sabe-se que, devido ao 

número de ligações, quando a estrutura molecular do alginato é enriquecido com GulA 

se torna mais rígida, enquanto a estrutura enriquecida com ManA é mais flexível (Zazzali 

et al. 2019). E o amplo uso desse polissacarídeo se deve a sua capacidade de formar géis 

na presença de cátions divalentes, como íons de cálcio (Braccini e Pérez, 2001). 

A gelificação, no caso do alginato, é o resultado de interações fortes e específicas entre 

íons de cálcio e blocos de resíduos de ácido gulurônico, ligados por altos coeficientes de 

seletividade (Braccini e Pérez, 2001; Cao et al. 2020). O modelo da “caixa de ovos” (ou 

Egg-Box) (Grant et al. 1973), indica que os blocos de G ao longo da cadeira de alginato 

adotam uma conformação helicoidal, formando regiões curvadas na estrutura (Fang et al. 

2007). Duas cadeias de G antiparalelas formam dímeros com cátions divalentes, como 

Ca2+, dando a forma de Caixa de Ovos (Fig. 1; Fang et al. 2007; Cao et al. 2020). 

 

 

Figura 2: Imagem esquemática ilustrando o modelo de caixa de ovos de alginato de Ca, 

conforme proposto por Morris et al., 1978. 
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Algumas características das esferas de alginato como a força mecânica e a estabilidade 

são significativamente influenciadas pela sua composição (massa molar e proporção de 

blocos G/M) e concentração do polímero, assim como pelo tipo e concentração do agente 

de reticulação (Martinsen et al. 1989; Moreira et al. 2006; De Jesus et al. 2019). A 

bactérias presentes nos RAS também são um fator determinante para a estabilidade das 

esferas (Cruz et al. 2013). Em vista disso, o objetivo deste estudo foi produzir esferas de 

alginato uniformes e estáveis, para imobilização de Nannochloropsis oceanica e, avaliar 

seu crescimento e potencial remoção de nutrientes acumulados nos sistemas de 

recirculação de água, que de outra forma seriam descartados no ambiente natural, 

contribuindo assim para a promoção da sustentabilidade e eficiência desses sistemas 

aquícolas. 
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2. OBJETIVO  

 

2.1 Objetivos Geral 

O objetivo geral do trabalho é otimizar a produção de esferas de alginato de sódio, e sua 

eficiência na imobilização da microalga Nannochloropsis oceanica, para a remoção de 

nutrientes presentes em efluentes de sistemas de recirculação de água. 

 

2.2 Objetivos Específicos 

i. Analisar se há influência das diferentes concentrações de biopolímero, na 

formação das esferas gelificadas; 

ii. Avaliar como as concentrações de agente reticulante podem afetar a resistência e 

estabilidade das esferas formadas; 

iii. Determinar o intervalo de tempo mais adequado para a gelificação das esferas no 

cloreto de cálcio; 

iv. Analisar se as características das esferas são afetadas e alteradas pelo fosfato 

durante o processo de formação das esferas de alginato; 

v. Analisar como as variações de salinidade ao longo do tempo podem afetar na 

estabilidade das esferas; 

vi. Verificar a eficiência de banhos extras de cloreto de cálcio em diferentes 

momentos do experimento; 

vii. Investigar a influência de fatores bióticos na estabilidade das esferas.  
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Resumo 

O crescimento da aquicultura nas últimas décadas decorre do aumento da demanda global 

por proteína animal, o que torna os sistemas intensivos mais adequados para suprir essas 

necessidades. No entanto, à medida que o cultivo se intensifica, as concentrações de 

compostos nitrogenados, fosfatados e matéria orgânica em suspensão e dissolvida na água 

aumentam. A imobilização de microalgas em esferas de alginato foi explorada como uma 

alternativa para o tratamento de efluentes provenientes de sistemas de recirculação de 

água. Nesse contexto, a eficiência da microalga Nannochloropsis oceanica foi 

investigada através de análises da remoção de nitrato e fosfato. A resistência das esferas 

produzidas foi testada através de experimentos de compressão utilizando um 

texturômetro, equipado com uma célula de carga de 5 kg. As esferas possibilitaram o 

transporte de nutrientes do meio para as células de microalgas, promovendo a assimilação 

e, consequentemente, o crescimento de N. oceanica. No entanto, a estabilidade das esferas 

foi comprometida por bactérias presentes em sistemas de recirculação de água, tornando-

se um fator negativo na durabilidade das matrizes. Os resultados gerados contribuirão 

para o aprimoramento no desenvolvimento de tecnologias avançadas para o tratamento 

de efluentes. 

 

Palavras-chave: Encapsulamento, bactéria, assimilação, nitrato, fosfato.  
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1. Introdução 

A aquicultura emerge como uma peça crucial para a segurança alimentar global, 

representando 49% da produção mundial de pescado em 2020, equivalente a um 

substancial montante de US$ 265 bilhões (Wang et al., 2021; FAO, 2022). O crescimento 

da aquicultura nas últimas décadas é resultado direto do incremento na demanda global 

por proteína animal, aliado à estabilização das capturas, motivando o desenvolvimento de 

sistemas intensivos de produção para suprir esta demanda (Little et al., 2016).  

Nesse contexto, os sistemas de recirculação de água (Recirculating Aquaculture 

Systems - RAS) despontam como métodos intensivos e altamente eficazes de produção 

aquícola em ambientes controlados. Tais sistemas não apenas proporcionam cronogramas 

previsíveis e taxas de crescimento monitoradas, mas também reduzem consideravelmente 

os riscos associados a surtos de doenças (Ebeling e Timmons, 2012; Bueno e Soto, 2017; 

Chen et al., 2018; Ahmed e Turchini, 2021). Além disso, sua característica mais marcante 

reside na sustentabilidade, permitindo a reciclagem de 90-99% da água utilizada, 

tornando-os consideravelmente menos dependentes de recursos hídricos em comparação 

com métodos convencionais (Ebeling e Timmons, 2012).  

Entretanto, apesar da notável eficiência no uso da água (Naylor et al., 2000; 

Ahmed et al., 2019; Ahmed e Turchini, 2021), os sistemas intensivos de cultivo em RAS 

enfrentam um desafio substancial, a tendência à acumulação de compostos nitrogenados 

e fosfatados, provenientes tanto da ração quanto do metabolismo dos organismos 

(Rurangwa e Verdegem, 2014; Ahmed e Turchini, 2021). Dado que o efluente do RAS 

apresenta concentrações elevadas de compostos que podem induzir à eutrofização do 

meio ambiente e que, a presença desses compostos pode causar danos ao nível de oxigênio 

dissolvido na água, o que pode ter um impacto negativo no estado trófico e na vida 
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aquática, ocasionando o crescimento de fitoplâncton e florações de algas, causando 

eutrofização (Metcalf & Eddy, 2003). Uma das abordagens para lidar com estes 

compostos nitrogenados tóxicos, reside no uso de filtros biológicos nitrificantes, onde as 

bactérias desempenham um papel crucial ao oxidar a amônia (NH4
+) a nitrito (NO2

-) e, 

em seguida, a nitrato (NO3
-), que tende a se acumular no sistema (Hagopian e Riley, 1998, 

Ebeling e Timmons, 2012). No entanto, estudos demonstram que concentrações elevadas 

de nitrato na água podem causar toxicidade aos organismos, oxidando a hemoglobina no 

plasma (Monsees et al., 2017; Yu et al., 2022) e consequentemente, reduzindo o 

crescimento e a sobrevivência dos peixes (Monsees et al., 2017; Yang et al., 2019; Isaza 

et al., 2020; Yu et al., 2021).  

Outro desafio premente é a presença de fosfato (PO4
3-) nos RAS, decorrente do 

excesso de fósforo adicionado na formulação da ração, que muitas vezes não é consumido 

pelos organismos cultivados ou é excretado por estes (Rodehutscord e Pfeffer, 1995; 

Coloso et al., 2003). Embora não seja diretamente tóxico para os organismos cultivados, 

o fosfato liberado nos efluentes de RAS pode também desencadear problemas de 

eutrofização (EPA, 1973; Coloso et al., 2003; Cao et al., 2020). Diante desse cenário, 

torna-se crucial explorar alternativas para a remoção eficaz desses compostos, tanto de 

forma biológica quanto química (Li et al., 2023).  

Nesse contexto, as microalgas emergem como potenciais aliadas contra a 

acumulação de nutrientes no RAS (Posadas et al., 2015; Gao et al., 2016; Egloff et al., 

2018; Han et al., 2019; Huang et al., 2020; Tom et al., 2021; Mahari et al., 2022; Sarkheil 

et al., 2022). Esses organismos unicelulares fotossintéticos, notórios por sua capacidade 

de converter dióxido de carbono, luz e nutrientes como nitrato e fosfato em biomassa, 

apresentam-se como essenciais para o tratamento biológico de águas residuais (Olaizola, 
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2003; Chinnasamy et al., 2010). Dentro desse contexto, as microalgas do gênero 

Nannochloropsis, reconhecida por sua alta produtividade e aplicação na aquicultura (Ma 

et al., 2016; Radakovits et al., 2013). 

É reconhecido que as microalgas são capazes de assimilar diretamente compostos 

nitrogenados e fosfatados, e essa abordagem já vem sendo estudada sem a necessidade de 

imobilizá-las (de la Noue e de Pauw, 1988; Becker, 2004; Han et al., 2019). No entanto, 

a aplicação em suspensão apresenta limitações no tratamento de efluente, especialmente 

na retirada ou separação da biomassa de algas do efluente tratado. Ademais, a aplicação 

de microalgas em suspensão em sistemas de recirculação de água aumenta os riscos de 

contaminação (bloom) e entupimento dos poros e tubos do biofiltro (Ramli et al., 2017). 

Uma estratégia promissora para potencializar o papel das microalgas na remoção de 

nutrientes reside na imobilização desses organismos em matrizes sólidas, destacando-se 

o alginato como uma abordagem sustentável para aprimorar a qualidade da água e a 

produção aquática (Ramli et al., 2017).  As microalgas imobilizadas ou aderidas oferecem 

mais estabilidade às células, reduzindo o vazamento de células na fase aquosa e 

prevenindo potencialmente contaminações e entupimentos. Biopolímeros, como o 

alginato, não tóxicos, transparentes e hidrofílicos, são comumente empregados (Emparan 

et al., 2019). A imobilização de microalgas utilizando alginato tem se mostrado eficaz na 

remoção de nutrientes solúveis de efluentes provenientes da aquicultura (Sarkheil et al., 

2022; Ramli et al., 2017). No entanto, a utilização dessa biotecnologia em água doce ou 

em salinidades baixas é mais recorrente devido, principalmente, à influência da salinidade 

na força mecânica e na estabilidade das esferas de alginato. Motivada pela perda de 

afinidade do alginato na presença de cátions divalentes como o cloreto de cálcio (CaCl2), 

utilizado como solução reticulante na preparação dos géis (Martinsen et al., 1989; 
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Braccini e Pérez, 2001; Moreira et al., 2006; De Jesus et al., 2019). Além disso, outro 

fator que afeta a resistência mecânica das esferas é a presença de bactérias presentes nos 

RAS, pois utilizam os polímeros de alginato como fonte de carbono, reduzindo sua 

estabilidade e possuindo a capacidade de quebrar as ligações do alginato, resultando na 

degradação do gel (Cruz et al., 2013). 

Assim, o presente estudo almeja preencher essa lacuna, buscando otimizar a 

estabilidade de esferas de alginato em água salgada para imobilização de N. oceanica. 

Além disso, visa avaliar o potencial dessas esferas na remoção de nitrato e fosfato em 

sistemas de recirculação de água, considerando também a influência de fatores bióticos 

(e.g. bactérias, microrganismos) e abióticos na estabilidade de esferas de alginato. 

 

2. Material e Métodos  

2.1.  Cultivo de microalgas 

N. oceanica Suda e Miyashita 2002 (Eustigmatophyceae), foi obtida da coleção do 

Laboratório e Produção de Microalgas do Instituto de Oceanografia da Universidade 

Federal do Rio Grande (FURG/Brasil). A cepa foi cultivada em meio f/2 (Guillard, 1975) 

preparado com água do mar natural (salinidade 28). A água do mar foi primeiro filtrada 

por um filtro de areia, seguido de um filtro de polipropileno de 1,0 µm e autoclavada a 

121 °C e 15 PSI por 15 minutos. O inóculo foi transferido um Erlenmeyer de 125 mL, 

com pH inicial 8, mantido em incubadora a 23 °C, iluminação (100 µmol photons⋅m−2⋅s−1) 

e fotoperíodo controlados (12:12), até a realização do experimento. 
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2.2. Imobilização em alginato  

A preparação das esferas de alginato de sódio foram adaptadas de Emparan et al., (2019), 

modificando o tempo de agitação e sem autoclavar a solução de alginato. As soluções de 

alginato de sódio PA (C6H7(NaO)6)n (Dinâmica Ltda. – Indaiatuba, SP, BR) foram 

preparadas em agitação constante de 300 RPM em um agitador magnético, por 

aproximadamente 4h, em água destilada. Após completa diluição, a solução de alginato 

foi diluída com a cultura de N. oceanica, previamente concentrada por centrifugação por 

10 min a 1610×g. A concentração inicial do cultivo inoculado foi de 3,5×105 cel⋅mL-1. A 

suspensão de microalgas foi misturada com 10 mL de solução de alginato de sódio em 

uma proporção 1:1 (v/v). A mistura foi extrudada através de uma bureta de 20mL 

adaptada com uma ponteira de 200 µL, para obter esferas de 3mm, nas soluções de cloreto 

de cálcio (CaCl2) em constante agitação, visando o endurecimento das esferas. Após 

agitação, as esferas foram retiradas da solução de cloreto de cálcio para serem analisadas. 

 

2.3. Planejamento experimental 

2.3.1. Delineamento Composto Central Rotacional 

Foi utilizada a Metodologia de Superfície de Resposta (MSR) empregando-se um 

planejamento experimental de Delineamento Composto Central Rotacional, com cinco 

fatores (concentração de alginato de sódio, concentração de cloreto de cálcio, 

concentração de fosfato, tempo de endurecimento e salinidade) e dois níveis (DCCR 25), 

usando-se o software JMP (versão 17.2.0, SAS Institute, Inc., Cary, NC). Os fatores e 

níveis do DCCR estão detalhados na Tabela 1. 
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Tabela 1: Fatores e níveis do DCCR, testando diferentes níveis de alginato, cloreto, 

tempo de endurecimento, salinidade e fosfato. Legenda dos padrões: + = nível alto, - = 

nível baixo, a = ponto axial inferior, A = ponto axial superior, 0 = ponto central. 

Fatores Variáveis Níveis 

a - 0 + A 

Alginato (g/100mL) X1 1 1,5 2 2,5 3 

Cloreto (g/100mL) X2 2 4,0 6 8,0 10 

Fosfato (mg/L) X3 0 2,5 5 7,5 10 

Salinidade (g/L) X4 0 7,5 15 22,5 30 

Tempo (min) X5 10 15,0 20 25,0 30 

 

Pelo planejamento experimental, foi definida uma matriz com 29 ensaios (veja em 

Material Suplementar 1, Tabela MS1), representando um experimento fatorial fracionado, 

sendo 16 ensaios nos níveis baixo (-) e alto (+), 10 ensaios nos pontos axiais (a, A) e, por 

fim, 3 ensaios nos pontos centrais (0) para determinar a variabilidade do planejamento. 

As respostas observadas foram a resistência e circunferência das esferas, e crescimento 

das microalgas, que serão definidas posteriormente. Baseado nos resultados 

experimentais obtidos, um modelo empírico polinomial quadrático foi ajustado para 

correlacionar os fatores e as respostas (Equação 1). 

𝑌 = 𝛽0 +∑𝛽𝑖𝑋𝑖

5

𝑖=1

+∑𝛽𝑖𝑖𝑋𝑖
2

5

𝑖=1

+∑∑𝛽𝑖𝑗𝑋𝑖𝑋𝑗

5

𝑖=1

4

𝑖=1

 

Onde Y é a resposta, β0 é o intercepto, βiXi é o efeito linear, βiiXi
2 é o efeito quadrático, 

βijXiXj é o efeito de interação entre as variáveis independentes (Xi e Xj). 
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2.3.2. Experimento de otimização 

Os 29 ensaios delineados pelo planejamento experimental foram conduzidos de forma 

simultânea, conforme detalhado no Material Suplementar 1, Tabela MS1. Este 

experimento foi realizado utilizando frascos de Erlenmeyer com capacidade útil de 50 

mL, mantidos em agitação constante a 150 RPM em uma mesa agitadora orbital 

(MA140/CFT - M T MARCONI, Brasil), ao longo de um período de 14 dias, em 

disposição aleatória. Cada unidade experimental continha vinte esferas de alginato de 

sódio para possibilitar a análise, no 14º dia, das respostas de estabilidade, densidade e 

circunferência das esferas. 

 

2.4. Avaliação da otimização 

2.4.1. Análise da estabilidade das esferas 

A estabilidade das esferas foi medida pela sua resistência mecânica por meio de um teste 

de compressão utilizando um texturômetro (Stable Microsystems, SMD TA.XP2i, United 

Kingdom), equipado com uma célula de carga de 5kg. Os parâmetros para essa análise 

seguiram a metodologia adaptada De Jesus et al., (2019). A compressão de pelo menos 

10 esferas foi realizada, individualmente, até que 70% da esfera fosse deformada, a uma 

velocidade de compressão de 0,05 mm⋅s⁻¹ e aplicando uma força de gatilho de 0,020 N. 

A distância entre a sonda (P/0.5, diâmetro de 12,7 mm) e a placa plana foi ajustada para 

10 mm. A estabilidade nesta análise foi medida de acordo com a resistência de cada esfera 

(em grama-força). 
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2.4.2. Análise do crescimento celular 

O crescimento das microalgas dentro das esferas foi medido por análise da cor. Pelo 

menos 10 esferas de alginato de cada tratamento foram colocadas em uma caixa de luz, 

fornecendo iluminação constante e homogênea, e as imagens foram capturadas utilizando 

uma câmera digital. Posteriormente, as imagens foram avaliadas pelo software ImageJ 

(National Institute of Health, Maryland, EUA) para determinar o crescimento médio 

baseado na comparação da cor das esferas. A escala de cada imagem foi ajustada com uso 

de uma escala milimétrica e, em seguida, as esferas foram reconhecidas pelo programa 

ajustando-se a configuração de limite de cor. Uma vez reconhecidas, foram medidas a 

área, a média, o desvio padrão e valor máximo e mínimo de cinza. A descrição detalhada 

de como utilizar o ImageJ para medição de crescimento encontra-se no Material 

Suplementar 2.  

 

2.4.3.  Análise de circunferência 

As imagens capturadas anteriormente também foram utilizadas para analisar a 

circunferência das esferas. Após ajuste da escala, a imagem foi transformada para preto 

e branco do tipo 8 bits. Após isto, foi ajustado o limite de preto e branco para o 

reconhecimento das esferas pelo programa. Uma vez reconhecidas as esferas, foram 

medidas a área, o valor médio de cinza, e os valores de forma e diâmetro de Feret. Para 

isso, foi selecionada a análise de partículas e de sobreposição das partículas. A descrição 

detalhada de como utilizar o ImageJ para medição de tamanho consta do Material 

Suplementar 3. 
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2.4.4. Validação do modelo empírico polinomial quadrático 

Após os processos de otimização, foi realizada a validação conjunta do modelo empírico 

polinomial quadrático. Para isto, foi empregado o índice de desejabilidade, ou seja, a 

combinação das variáveis significativas que gera a melhor resposta global. A validação 

foi realizada seguindo a mesma metodologia do experimento de otimização (Item 2.3.2), 

porém, apenas a melhor combinação de fatores foi testada. O modelo é considerado 

validado se a resposta global obtida estiver dentro do intervalo de confiança do modelo. 

 

2.5. Caracterização do efluente 

O efluente utilizado neste trabalho foi coletado de um tanque de recirculação da Estação 

Marinha de Aquicultura (EMA – FURG) são cultivados os reprodutores de miragaia 

(Pogonias courbina). O tanque de recirculação tem uma capacidade de 12.000 L e 

utiliza água natural do mar com as seguintes características de temperatura = 26,49 ± 

0,59 °C, pH = 7,69 ± 0,11, oxigênio dissolvido = 5,3 ± 0,62, e salinidade = 35,9 ± 1,35 

g.L -1. 

 

2.6. Remoção de nutrientes do efluente  

Para o monitoramento da remoção de nitrato e fosfato, foi realizada a coleta de 2mL de 

cultivo a cada 48h. As amostras dos cultivos foram filtradas em microfiltro de fibra de 

vidro (Nuclepore, 28 mm de diâmetro e retenção de partículas de até 0,6 µm) e o filtrado 

foi utilizado para determinação das concentrações de nitrato (N-NO3
-) e Fosfato (P-PO4 

-

3), seguindo a metodologia de Strickland e Parsons (1972). 
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2.7. Assimilação de nutrientes 

Após o processo de otimização, um experimento de assimilação de nutrientes seguindo 

as mesmas condições foi realizado. Em unidades experimentais com volume útil de 50mL 

foram adicionadas 20 esferas de alginato feitas de acordo com o resultado encontrado no 

experimento de otimização. Nesse experimento foram comparados o crescimento e a 

eficiência das esferas de alginato contendo microalgas, quando comparadas com células 

livres de microalgas, na remoção de nutrientes. A montagem do experimento de 

assimilação foi conduzindo com microalgas livres e imobilizadas, em efluente ou em 

meio f/2, e esferas de alginato sem microalgas foram usadas como controle (Tabela 2). 

Todos os tratamentos foram realizados em triplicatas. A concentração inicial do cultivo 

inoculado foi de 3,5×105 cel⋅mL-1. Para as análises de remoção de nutrientes foram 

coletados, a cada 48h, 1 ml de cada unidade experimental e filtrados através de um filtro 

de seringa adaptado com microfiltro de fibra de vidro (Nuclepore, 28 mm de diâmetro e 

retenção de partículas de até 0,6 µm) para análise de nitrato e fosfato. 

 

Tabela 2: Tratamentos do experimento de assimilação 

Tratamentos Descrição 

T1 Esferas em branco em efluente 

T2 Microalga imobilizada em efluente 

T3 Microalga livre em efluente 

T4 Microalga imobilizada em f/2 

T5 Microalga livre em f/2 
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2.8. Determinação da taxa de crescimento celular da microalga 

Para os tratamentos com microalgas livres, alíquotas de 2 mL foram coletas e fixadas com 

formol (100 µL) para realização da contagem celular. Para os tratamentos com microalgas 

imobilizadas, adaptamos a metodologia descrita por Murujew et al. (2021), onde para 

cada esfera foram adicionados 300 µL de citrato de sódio (solução 0,5 M) em tubos de 

Eppendorf que foram, posteriormente, concentrados por centrifugação durante 5 min a 

1610×g (Rondo, CR-1512 – CAPP) e resuspendidas com 100 µL de formol 4% (v/v). A 

contagem de células foi realizada em microscópio óptico (objetiva × 40) em câmara de 

Neubauer.  

 

2.9. Experimento de banho de reforço 

Nesta etapa, foram refeitos os experimentos de otimização das esferas e o de assimilação 

dos nutrientes, para avaliar a eficiência do banho de reforço na estabilidade das esferas, 

adicionando dessa vez banhos de CaCl2 a cada cinco dias. Em unidades experimentais de 

50mL, foram adicionadas vinte esferas de alginato feitas de acordo com o resultado 

encontrado no experimento de otimização. Elas foram retiradas do meio e expostas ao 

banho de CaCl2 (6%) por vinte minutos, depois eram devolvidas a mesa agitadora em 

seus respectivos meios. O experimento teve duração de 14 dias e ao final, foram 

realizadas análises de resistência, crescimento celular e circunferência. 

 

2.10. Presença de bactérias 

Para avaliar a influência de fatores bióticos, comunidades bacterianas, na estabilidade das 

esferas no efluente do RAS, foi analisado o efeito da autoclavagem nos meios onde as 

esferas foram colocadas. O experimento consistiu em três tratamentos: um efluente 
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sintético filtrado e autoclavado (ES); um efluente natural filtrado e autoclavado (EA); e 

um efluente natural apenas filtrado (EF). Em unidades experimentais de 50 mL foram 

adicionadas vinte esferas de alginato, sem microalga, seguindo os mesmos critérios do 

experimento de otimização. Todos os tratamentos foram feitos em triplicatas e o 

experimento foi iniciado com 3,6 mg/L de fosfato. Os tratamentos foram expostos às 

mesmas condições dos experimentos anteriores durante quatro dias. A medição de 

tamanho foi realizada utilizando o software ImageJ (Item 2.4.2).  

 

2.10.1. Contagem celular de bactérias 

Amostras de 20mL foram fixadas em solução de formalina 4% (concentração final) e 

mantidas em tubos de centrifugação. Para a determinação da abundância de bactérias, as 

amostras fixadas foram filtradas em membranas de policarbonato (Nuclepore, 25 mm e 

diâmetro do poro de 0,2 μm) previamente escurecidas com Irgalan Black e coradas com 

1% de solução de laranja de acridina a uma concentração de 1 μg·mL-1 (Hobbie et al., 

1977). As bactérias foram fotografadas usando uma câmera acoplada a um microscópio 

Axioplan-Zeiss de epifluorescência, com uma ampliação final de 1000×, para contagem 

posterior de 20 campos aleatórios. As bactérias foram classificadas em cocos, bacilos e 

filamentos. 

 

2.11. Análise estatística 

Os resultados do experimento de otimização, isto é, os efeitos dos fatores e suas 

interações, foram analisados através da ANOVA, com nível de significância de 5%, com 

a foi utilização do software JMP versão 17.2.0. Os demais experimentos foram analisados 

por teste t de Student ou por ANOVA, ambos com nível de significância de 5%, seguido 
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de teste post hoc de Tukey utilizando o software Prism versão 7.0e (GraphPad Software 

Inc., Boston, MA, EUA).  

 

3. Resultados 

3.1. Otimização das esferas e validação do modelo 

Na Tabela 3 estão apresentados os efeitos principais, as interações de duas vias e os 

termos quadráticos considerados significativos (α = 0,05) para construção do modelo de 

superfície de resposta. Os efeitos principais de cloreto e da salinidade foram considerados 

significativos, assim como os seus termos quadráticos. Apesar do alginato não ter sido 

considerado significativo (P=0,08217), foi mantido para a construção do modelo devido 

ao efeito da hereditariedade, que recomenda que termos de ordem inferior (efeitos 

principais) sejam mantidos se termos de ordem superior (interações ou termos 

quadráticos) forem significativos. O termo quadrático do alginato foi considerado e a sua 

interação com cloreto foram considerados significativos (P < 0,003). Por fim, os fatores 

concentração de fosfato e tempo de endurecimento não foram considerados significativos 

(P > 0,05) e, como não possuíam termos de ordem superior, foram excluídos do modelo.  

 

Tabela 3: Sumário dos efeitos significativos para construção do modelo de superfície de 

resposta. 

Termos Valor P 

Cloreto 0,00042 

Alginato × Alginato 0,00060 

Salinidade × Salinidade 0,00073 

Salinidade 0,00171 
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Alginato × Cloreto 0,00363 

Cloreto × Cloreto 0,00638 

Alginato 0,08217 

 

A análise de variância demonstrou que o modelo para a resposta resistência foi 

significativo (P = 0,0053). De acordo com o modelo empírico obtido para resistência, 

alginato (X1) e cloreto (X2) apresentaram efeitos positivos, assim como sua interação 

(X1X2), enquanto salinidade (X4) apresentou efeito negativo (Equação 2).  

𝑌 = 12,16 + 8,70 × 𝑋1 + 5,10 × 𝑋2 − 27,46 × 𝑋4 + 8,78 × 𝑋1𝑋2 − 6,09 × 𝑋1
2 −

9,45 × 𝑋2
2 + 65,86 × 𝑋4

2  

 

A Figura 1A apresenta a interação entre as concentrações de alginato e cloreto sobre a 

resposta resistência. Percebe-se que a resistência das esferas de alginato possui uma 

relação direta com as concentrações de alginato e cloreto empregadas.   

 



   

 

36 
 

 

Figura 1: Superfícies da interação entre alginato × cloreto para as respostas resistência 

(A), circunferência (B) e crescimento das microalgas (C). 

 

Para a resposta circunferência, a análise de variância demonstrou que o modelo também 

foi significativo (P = 0,0159). Pelo modelo empírico obtido, observa-se que alginato (X1) 

e salinidade (X4) apresentaram efeitos positivos, assim como a interação entre alginato e 

cloreto (X1X2), enquanto cloreto (X2) apresentou efeito negativo (Equação 3).  

𝑌 = 0,90 + 0,0023 × 𝑋1 − 0,002 × 𝑋2 + 0,00083 × 𝑋4 + 0,0055 × 𝑋1𝑋2 − 0,017 ×

𝑋1
2 + 0,004 × 𝑋2

2 + 0,002 × 𝑋4
2  
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A Figura 1B apresenta a interação entre as concentrações de alginato e cloreto sobre a 

resposta circunferência. Percebe-se que a circunferência das esferas de alginato possui 

um máximo de resposta com uma concentração de alginato em torno de 2 g·100mL-1. 

Para a concentração de cloreto, percebe-se que concentrações menores são mais 

eficientes. 

 

Para a resposta crescimento, a análise de variância demonstrou que o modelo foi 

altamente significativo (P < 0,0001). Pelo modelo empírico, observa-se que alginato (X1), 

cloreto (X2) e salinidade (X4) apresentaram efeitos negativos, enquanto a interação entre 

alginato e cloreto (X1X2) foi positiva (Equação 4).  

𝑌 = 73,43 − 2,011 × 𝑋1 − 4,605 × 𝑋2 − 3,956 × 𝑋4 + 8,834 × 𝑋1𝑋2 + 2,366 ×

𝑋1
2 + 6,304 × 𝑋2

2 + 2,348 × 𝑋4
2  

 

A Figura 1C apresenta a interação entre as concentrações de alginato e de cloreto sobre a 

resposta crescimento. Percebe-se que o crescimento das microalgas nas esferas de 

alginato possui uma relação inversa com ambas as concentrações. 

 

Como os comportamentos das respostas divergiram quanto aos níveis ótimos dos fatores, 

fez-se necessária à sua otimização conjunta, empregando-se para isso o índice de 

desejabilidade (Figura 2). De acordo com a análise, a resposta global média capaz de ser 

obtida é de 51,2 ± 34,1 gramas-força de resistência, 0,903 ±0,008 de circunferência e 71,1 

± 4,25 de cinza (i.e. crescimento) para a combinação de 2 g·100mL-1 de alginato, 7 

g·100mL-1 de cloreto e 30 g·L-1 de salinidade (Tabela 5). Para a validação do modelo 
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empírico, os fatores concentração de fosfato e tempo de endurecimento foram mantidos 

nos seus valores do ponto central, 5 mg·L-1 e 20 minutos, respectivamente (Tabela 1). De 

uma fora geral, o modelo empírico não foi validado, pois os valores observados de 

resistência e de crescimento estiveram fora do intervalo de confiança predito, sendo 12,7 

gramas-força e 61,0 de cinza, respectivamente. Apenas o valor observado de 

circunferência coincidiu com o predito (0,903).  

 

 

Figura 2: Análise de desejabilidade dos fatores concentração de alginato, cloreto e 

salinidade.  
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3.2. Assimilação de nutrientes 

A Figura 3 apresenta os resultados para a assimilação de nitrato, para microalgas 

imobilizadas e livres, tanto em efluente quanto em meio f/2. As concentrações iniciais de 

nitrato entre os tratamentos com efluente e com meio f/2 foram estatisticamente diferentes 

(P < 0,0001), sendo 55 mg·L-1 e 75 mg·L-1, respectivamente. De uma forma geral, 

observam-se dois grupos estatisticamente distintos (P < 0,003) ao longo do experimento. 

Curiosamente, os tratamentos em efluente não apresentaram diferença estatística entre si, 

independente da presença de microalgas ou de esferas, atingindo uma assimilação média 

de 45% do nitrato inicial após nove dias. Já os tratamentos em meio f/2, também não 

apresentaram diferença estatística entre si, porém, apresentaram uma assimilação média 

de nitrato superior ao dos tratamentos em efluente, de cerca de 81%. 

 

 

Figura 3: Resultado da ANOVA (α = 0,05) para a assimilação de nitrato. (T1) Esferas em 

branco em efluente, (T2) Microalga imobilizada em efluente, (T3) Microalga livre em 

efluente, (T4) Microalga imobilizada em f/2 e (T5) Microalga livre em f/2.  
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A Figura 4 apresenta os resultados para a assimilação de fosfato, para microalgas 

imobilizadas e livres, tanto em efluente quanto em meio f/2. Assim como no nitrato, as 

concentrações iniciais de fosfato diferiram entre efluente e meio f/2 (P < 0,0001). Porém, 

o comportamento do fosfato apresentou variações ao longo do experimento. 

Curiosamente, no efluente, as concentrações de fosfato aumentaram no fim do 

experimento, atingindo concentrações superiores à inicial, sendo 104% no tratamento T1, 

118% no tratamento T2 e 139% no tratamento T3, porém, não apresentaram diferença 

estatística entre si. Ao contrário, no meio f/2, as concentrações de fosfato após nove dias 

foram consideravelmente menores, de cerca de 58%.  

 

 

Figura 4: Resultado da ANOVA (α = 0,05) para a assimilação de fosfato. (T1) Esferas em 

branco em efluente, (T2) Microalga imobilizada em efluente, (T3) Microalga livre em 

efluente, (T4) Microalga imobilizada em f/2 e (T5) Microalga livre em f/2.  

 

O crescimento das microalgas nos diferentes tratamentos está apresentado na Figura 5. 

Todos os tratamentos apresentaram crescimento, em relação ao inóculo, porém o 
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tratamento T4 foi o que apresentou maior crescimento (P < 0,003), com uma média de 

8,4×106 ± 2,7×106 células·mL-1. Os tratamentos T2, T3 e T5 não diferiram entre si, 

apresentando um crescimento médio de 2,2×106 ± 5,7×105 células·mL-1. 

 

 

Figura 5: Resultado da ANOVA (α = 0,05) para crescimento das microalgas. (T2) 

Microalga imobilizada em efluente, (T3) Microalga livre em efluente, (T4) Microalga 

imobilizada em f/2 e (T5) Microalga livre em f/2.  

 

Em comparação com o resultado da validação, as esferas tiveram uma resistência 

significativamente inferior (P < 0,0001), caindo de 12,72 gramas-força para 5,37 gramas-

força, apresentando apenas 42% da resistência medida anteriormente.  

 

3.3. Efeito do banho de reforço 

O banho permitiu um aumento de 27% na resistência das esferas (P = 0,017). Porém, o 

aumento na resistência resultou num efeito negativo no crescimento (P < 0,0001), com 
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uma diminuição de 6%. Em contraste com o experimento de assimilação de nutrientes, as 

esferas do experimento que receberam banho não resistiram e se dissolveram, quase 

totalmente. Apesar disto, o comportamento de assimilação de nutrientes foi semelhante 

entre os dois experimentos (Figura 6). Os tratamentos em efluente reduziram nitrato em 

44%, enquanto o tratamento em meio f/2 reduziu em 86%. Da mesma forma, para o 

fosfato, os tratamentos em efluente tiveram uma produção de cerca de 23% de fosfato, 

enquanto o tratamento em meio f/2 consumiu 65% (Figura 7). Em comparação com o 

crescimento, o tratamento em efluente (T2, 3,0×106 ± 6,2×105 células·mL-1) foi 

estatisticamente inferior (P = 0,03) ao tratamento em meio f/2 (T4, 6,8×106 ± 1,9×106 

células·mL-1). 

 

 

Figura 6: Resultado da ANOVA (α = 0,05) para a assimilação de nitrato com banho de 

NaCl. (T1) Esferas em branco em efluente, (T2) Microalga imobilizada em efluente e 

(T4) Microalga imobilizada em f/2.  
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Figura 7: Resultado da ANOVA (α = 0,05) para a assimilação de fosfato com banho de 

NaCl. (T1) Esferas em branco em efluente, (T2) Microalga imobilizada em efluente e 

(T4) Microalga imobilizada em f/2.  

 

3.4. Efeito da presença de bactérias 

A Figura 8 apresenta as concentrações dos diversos morfotipos de bactérias encontradas 

nos tratamentos. A concentração de bactérias cocóides não apresentou diferença (P = 0,6) 

entre os tratamentos, com uma média de 9,4×103 ± 3,9×106 células·µL-1 (Figura 1A). 

Bacilos foi o morfotipo mais abundante (Figura 1B), sendo que o tratamento EF 

apresentou a maior concentração (2,8×104 ± 8,6×103 células·µL-1), sendo estatisticamente 

diferente (P < 0,03) dos tratamentos EA (1,2×104 ± 5,5×103 células·µL-1) e ES (3,3×103 

± 2,2×103 células·µL-1), que não diferiram entre si. As bactérias filamentosas foram o 

morfotipo menos abundante, sendo que o tratamento EF apresentou a maior concentração 

(5,6×103 ± 1,1×103 células·µL-1), sendo estatisticamente diferente (P < 0,005) dos 

tratamentos EA (1,6×103 ± 7,7×102 células·µL-1) e ES (1,4×103 ± 1,1×103 células·µL-1), 

que não diferiram entre si. De uma forma geral, o tratamento EF apresentou a maior 
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densidade bacteriana (4,5×104 ± 1,0×104 células·µL-1), estatisticamente superior (P < 

0,048) aos tratamentos EA (2,1×104 ± 1,1×104 células·µL-1) e ES (1,4×104 ± 7,8×103 

células·µL-1) que, novamente, não diferiram entre si.  

 

 

Figura 8: Resultado da ANOVA (α = 0,05) para a contagem de bactérias. (EF) Efluente 

natural apenas filtrado, (EA) Efluente natural filtrado e autoclavado e (ES) Efluente 

sintético filtrado e autoclavado.  

 

Quanto ao tamanho das esferas, os resultados variaram de acordo com os tratamentos. O 

tratamento ES apresentou esferas com cerca de 3,28 ± ,13 mm de diâmetro, sendo 

estatisticamente maiores (P < 0,0001) que as esferas do tratamento EA, que tinham 2,52 

± 0,21 mm de diâmetro, enquanto todas as esferas do tratamento EF se dissolveram. A 

assimilação de fosfato apresentou o mesmo comportamento, onde o tratamento ES foi 



   

 

45 
 

mais eficiente (P < 0,43), removendo 74% do fosfato. Os tratamentos EA e EF 

removeram, respectivamente, 53% e 35%, porém não apresentaram diferença estatística. 

 

4. Discussão 

4.1. Otimização das esferas e validação do modelo 

O experimento de otimização testou a influência de cinco fatores (concentração de 

alginato de sódio, de cloreto de cálcio, de fosfato, tempo de endurecimento e salinidade) 

na resistência e circunferência das esferas, e no crescimento das microalgas. As 

concentrações mais elevadas de alginato (2,5% e 3%) dificultaram o gotejamento e a sua 

produção, resultando em esferas mais achatadas. Estes resultados corroboram com 

resultados previamente reportados por De Jesus et al. (2019) e Damayanti et al. (2021). 

A circunferência das esferas na imobilização celular, quando o objetivo é a remoção de 

poluentes, tem um efeito evidente em sua estabilidade mecânica e química, uma vez que 

regula a velocidade de difusão, ou seja, quanto menor o tamanho das esferas, mais elevada 

a eficiência do processo (De Jesus et al., 2019).  

 

As concentrações de fosfato utilizadas foram significativamente altas em relação ao que 

pode ser encontrado em RAS, no entanto, não tiveram efeitos significativos em nenhuma 

das respostas avaliadas. Ao longo do experimento, as 20 esferas estiveram imersas em 

50mL de água marinha, contendo 5 mg/L de fosfato e salinidade 30 e, ao final do 

experimento, a recuperação das esferas foi de 100%. Apesar disso, os resultados 

encontrados foram inferiores aos preditos pelo modelo, possivelmente devido à presença 

de outras propriedades químicas que afetam a estabilidade das esferas. Ainda que o 
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fosfato seja um fator que pode desestabilizar as esferas, Tam e Wong (2000) 

demonstraram que concentrações abaixo de 6 mg L-1 não afetam a estabilidade química. 

 

A maior durabilidade e resistência para matrizes reticuladas foi com a concentração de 

6% de CaCl2, não afetando o crescimento celular das microalgas. De acordo com Cabrita 

et al. (2013), as esferas produzidas com concentrações superiores a 5% (p/v) de CaCl2 

são mais resistentes à salinidade e suportam melhor a agitação mecânica. Em relação ao 

crescimento celular, os resultados obtidos demonstraram uma performance inferior 

àquela prevista pelo modelo predito (61,0), possivelmente atribuível à difusão de 

nutrientes para o interior da esfera. Cabrita et al. (2013) monitoraram o crescimento de 

Phaeodactylum tricornutum imobilizada em esferas de alginato em águas estuarinas 

(salinidade 27). Os autores concluíram que géis espessos, reticulados com concentrações 

de CaCl2 acima de 4% (p/v), tinham alta resistência a difusão, contribuindo para dificultar 

a substituição de Ca2+ pelo Na+ presente na água, ocasionando na diminuição da perda de 

estabilidade das esferas. Esses resultados são similares aos encontrados por De Jesus et 

al. (2019), onde observou-se uma melhoria significativa no crescimento celular da 

microalga Desmodesmus subspicatus ao reticular as esferas com concentrações 

superiores a 5% de CaCl2. Os autores explicam que quanto menor a concentração de 

agente reticulante utilizada, maior a porosidade da matriz de alginato, facilitando a 

difusão de nutrientes e consequentemente desestabilizando o polímero. Esses resultados 

corroboram e reforçam as respostas observadas em relação ao crescimento celular no 

presente trabalho. 
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4.2. Assimilação de nutrientes 

O experimento de assimilação de nutrientes, embora não tenha sustentado as esferas que 

estavam em efluente por mais de 72h, obteve resultados positivos. Os tratamentos que 

continham esferas em meio f/2 (T4; T5) apresentaram resultados melhores em termos de 

assimilação de nutrientes e durabilidade que os tratamentos mantidos no efluente de RAS 

(T2; T3), em virtude da dissolução completa das esferas, como dito anteriormente. No 

entanto, em ambos os casos, a assimilação foi positiva. Esse desempenho positivo pode 

ser explicado pelo crescimento de N. oceanica nos tratamentos que continham células 

imobilizadas. Contudo, no efluente a presença da microalga não teve diferença 

significativa. 

 

O aumento nas concentrações de fosfato nos tratamentos com efluente pode estar 

relacionado à influência de microrganismos presentes no meio, não havendo consumo do 

fosfato devido à falta de adaptação das microalgas ao efluente. Estudos indicam que as 

microalgas acumulam ortofosfato na forma de polifosfatos e esse mecanismo é aumentado 

quando as células são privadas de nutrientes (De-Bashan et al., 2002; Kaplan et al., 2017). 

A cultura centrifugada para a imobilização no experimento não estava privada de 

nutrientes antes da imersão nos respectivos meios, portanto, é possível que as células 

possam acumular mais fosfato do que o apresentado no presente estudo, o que foi 

inviabilizado por fatores bióticos. Ainda assim, houve a redução, em meio f/2, de 58% do 

valor inicial em nove dias, valor próximo ao encontrado por Sarkheil et al. (2022) 

utilizando outra microalga verde (Scenedesmus quadricauda) que removeu 61% de 

fosfato de águas residuais artificiais em seis dias de experimento. 
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O maior crescimento celular observado no tratamento com microalga imobilizada em f/2 

comparado aos demais tratamentos podem ser explicado pode ser explicado pela maior 

eficiência de culturas imobilizadas na remoção de nutrientes quando comparada as células 

livres, como já foi demonstrado por Soo (2017). Contudo, as microalgas utilizadas neste 

trabalho já estavam aclimatadas no meio f/2, talvez seja necessário, a melhor aclimatação 

da microalga ao efluente. Segundo Emparan et al. (2019), Nannochloropsis sp. 

imobilizadas apresentam melhor atividade catalítica, viabilidade e taxa de crescimento do 

que os tratamentos com células livres. Esses reforçam as respostas de crescimento 

realizadas no presente trabalho. Foi observado, uma possível influência do efluente no 

crescimento celular, aumentando consequentemente a concentração de fosfato. O valor 

de referência para o crescimento em f/2 não foi atingido, indicando haver um desafio 

significativo nesse aspecto. O ideal seria que a cultura crescesse tão bem no efluente 

quanto em condições padrão, mas infelizmente isso não está acontecendo. É 

recomendável, para trabalhos futuros, a implementação de um tratamento prévio do 

efluente e mais tempo de aclimação das microalgas em efluente, antes de prosseguir para 

as próximas etapas do processo com as esferas. Essa abordagem pode contribuir para a 

diminuição dos efeitos inibitórios que observamos no crescimento. 

  

A diminuição da resistência das esferas, quando em comparação ao resultado de 

validação, por ter sido ocasionada devido à presença de microrganismos naturalmente 

presentes em RAS. Durante bastante tempo, a literatura predominante argumentou que a 

degradação das esferas de alginato em certas aplicações, como o tratamento de efluentes, 

e a subsequente liberação dos microrganismos imobilizados, que diminui a eficácia do 

processo, são causadas pela dissolução química das esferas (Cruz et al., 2013). 
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Covarrubias et al. (2011) descreve duas situações em que um agente de biotratamento é 

introduzido em águas residuais: (i) no melhor cenário ele enfrenta competição com a 

população bacteriana local, e (ii) no pior cenário, acaba atuando como uma fonte adicional 

de nutrientes para essa microfauna predatória, diminuindo em ambos os casos a eficácia 

do biofiltro. Os resultados apresentados por Cruz et al. (2013) corroboram os resultados 

obtidos nesse estudo, uma vez que em seus experimentos não houve degradação quando 

as águas residuais foram autoclavadas. 

A partir dessas observações, é possível propor algumas maneiras de como esses 

resultados poderiam contribuir para a sustentabilidade e eficiência dos sistemas de 

aquicultura em recirculação. Primeiramente, o uso de esferas imobilizadas em meio f/2 

demonstrou uma maior capacidade de assimilação de nutrientes em comparação com as 

células livres, sugerindo que essa abordagem pode ser mais eficiente na remoção de 

nutrientes de efluentes aquáticos. Portanto, a implementação de esferas imobilizadas em 

sistemas de aquicultura em recirculação pode melhorar a qualidade da água ao remover 

eficientemente nutrientes indesejados, contribuindo para a sustentabilidade desses 

sistemas. 

4.3. Experimento de banho 

Até o momento, este estudo foi pioneiro ao propor a recuperação das esferas após a 

exposição, com o intuito de reforçar o banho de CaCl2. A resposta desse experimento foi 

positiva, apesar de ter efeito negativo no crescimento. O que pode indicar que o aumento 

da resistência dificultou a difusão de nutrientes para dentro das esferas, ocasionando a 

redução do crescimento. Para futuras pesquisas, recomenda-se ajustes na metodologia, 

como possivelmente diminuir o intervalo de tempo entre os banhos de reforço. 
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4.4. Experimento de bactérias 

Nos resultados obtidos, foram encontrados diversos morfotipos de bactérias, entre eles os 

principais foram: bactérias cocóides (9,4×103 ± 3,9×106 células·µL-1), bactérias 

filamentosas (5,6×103 ± 1,1×103 células·µL-1) e bacilos (2,8×104 ± 8,6×103 células·µL-

1). O morfotipo predominante foi o de bacilos, com maior concentração no tratamento 

com efluente natural não autoclavado. Esse tratamento apresentou as maiores 

concentrações de morfotipos em relação aos outros dois tratamentos, validando a hipótese 

de que o processo de autoclavagem era o que diferenciava a durabilidade dos tratamentos. 

A desintegração das esferas de alginato está ligada a presença de populações microbianas 

no efluente natural, uma vez que quando realizado o processo de autoclavagem dos 

tratamentos, como evidenciado pelo fato de que apenas as esferas imersas em efluente 

natural não autoclavado se desintegraram completamente em 72 horas. O autor 

Covarrubias et al. (2011) identificou nove cepas de bactérias potencialmente 

degradadoras de alginato, membros do gênero Acinetobacter, naturalmente presentes em 

águas residuárias. As bactérias pertencentes a esse gênero podem ser da classe dos bacilos 

ou cocobacilos, o que corrobora com os morfotipos encontrados nesta pesquisa. De 

acordo com Tang et al. (2009) a degradação de alginato, em especial o polimerizado, é 

dificultada pela complexidade da molécula. No entanto, segundo Cruz et al. (2013), essas 

bactérias têm capacidade de degradar os blocos de construção do polímero por meio de 

suas enzimas quando o crescimento principal de sua população é sustentado por outras 

fontes de carbono. Os autores ainda relatam que mesmo que por um período curto de 

observação (96 horas), todas as cepas bacterianas sobreviveram e mantiveram suas 

populações, o que não poderiam fazer sem a ocorrência de monômeros de alginato. Em 

relação à presença de bactérias nos tratamentos com efluentes não tratados, é plausível 
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que as esferas de microalgas possam exercer um efeito inibitório sobre o crescimento 

bacteriano. Este fenômeno pode ser atribuído à possível liberação de substâncias 

antibacterianas por certas espécies de microalgas ou à competição por nutrientes, onde as 

microalgas podem consumir nutrientes essenciais para o crescimento bacteriano. Embora 

não tenham sido realizados testes específicos para investigar esses efeitos, é uma 

consideração pertinente para ser explorada em futuras pesquisas.  

 

4.5. Implicações práticas na Aquicultura 

Além dos resultados que evidenciam a eficácia na remoção de nutrientes no tanque de 

recirculação, as esferas de alginato contendo microalgas apresentam diversas vantagens 

em sua aplicabilidade na aquicultura e sustentabilidade. A imobilização das microalgas 

dentro das esferas facilita sua remoção, pois não estão dispersas livremente no tanque, 

tornando o processo mais simples, podendo ser realizado facilmente com o auxílio de 

uma peneira. Isso reduz os custos associados à remoção das microalgas do tanque, uma 

vez que, se estivessem livres, seria necessário filtrar todo o volume do tanque. Além disso, 

essa abordagem é mais econômica, pois permite a remoção dos nutrientes de forma 

biológica, sem a necessidade de investimentos em grandes maquinários, estruturas ou 

reagentes químicos, que poderiam comprometer a saúde dos organismos cultivados no 

sistema de recirculação. Por fim, essa técnica viabiliza a realização de estudos futuros 

sobre a reutilização dessa biomassa, como por exemplo, sua utilização na alimentação do 

zooplâncton que será incorporado ao cultivo, fechando assim o ciclo de utilização desse 

bioproduto. Contudo, a presença de comunidades microbianas no efluente pode ser um 

fator negativo sobre a resistência e durabilidade das esferas de alginato. Sugere-se para 

futuras pesquisas investigar a diversidade e atividade das cepas bacterianas degradadoras 
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de alginato em diferentes condições de efluente, bem como explorar estratégias para 

mitigar o impacto dessas bactérias na estabilidade das esferas de alginato. 

 

 

5. Conclusão 

O alginato de sódio como biopolímero na produção de esferas para a imobilização de 

Nannochloropsis oceanica se mostrou mais adequado na faixa de concentração de 2%, 

resultando em matrizes mais uniformes. A perspectiva da produção de esferas seguida de 

banhos reforço de CaCl2 é promissora, no entanto, recomenda-se o refinamento da 

metodologia adotada. As células de microalgas imobilizadas cresceram 

consideravelmente nas esferas e tiveram resultados promissores na remoção de nutrientes 

quando comparadas às células livres. Microrganismos naturalmente presentes em 

efluentes de RAS, como as bactérias degradadoras de alginato, podem afetar 

negativamente a estabilidade das esferas. 
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Material suplementar 1 

 

Tabela MS1: Matriz do DCCR com 29 ensaios, testando diferentes níveis de alginato, 

cloreto, tempo de endurecimento, salinidade e fosfato. Legenda dos padrões: + = nível 

alto, - = nível baixo, a = ponto axial inferior, A = ponto axial superior, 0 = ponto central. 

  Alginato Cloreto Tempo Salinidade Fosfato 

Ensaio Padrão (g/100ml) (g/100ml) (min) (g/L) (mg/L) 

1 a0000 1,0 6 20 15,0 5,0 

2 −−−−− 1,5 4 15 7,5 2,5 

3 −−−++ 1,5 4 15 22,5 7,5 

4 −−+−+ 1,5 4 25 7,5 7,5 

5 −−++− 1,5 4 25 22,5 2,5 

6 −+−−+ 1,5 8 15 7,5 7,5 

7 −+−+− 1,5 8 15 22,5 2,5 

8 −++−− 1,5 8 25 7,5 2,5 

9 −++++ 1,5 8 25 22,5 7,5 

10 0a000 2,0 2 20 15,0 5,0 

11 00a00 2,0 6 10 15,0 5,0 

12 000a0 2,0 6 20 0,0 5,0 

13 0000a 2,0 6 20 15,0 0,0 

14 00000 2,0 6 20 15,0 5,0 

15 00000 2,0 6 20 15,0 5,0 

16 00000 2,0 6 20 15,0 5,0 

17 0000A 2,0 6 20 15,0 10,0 
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18 000A0 2,0 6 20 30,0 5,0 

19 00A00 2,0 6 30 15,0 5,0 

20 0A000 2,0 10 20 15,0 5,0 

21 +−−−+ 2,5 4 15 7,5 7,5 

22 +−−+− 2,5 4 15 22,5 2,5 

23 +−+−− 2,5 4 25 7,5 2,5 

24 +−+++ 2,5 4 25 22,5 7,5 

25 ++−−− 2,5 8 15 7,5 2,5 

26 ++−++ 2,5 8 15 22,5 7,5 

27 +++−+ 2,5 8 25 7,5 7,5 

28 ++++− 2,5 8 25 22,5 2,5 

29 A0000 3,0 6 20 15,0 5,0 
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Material Suplementar 2 

 

Medição de Cor de esferas de alginato no Image J  

 

1. Abrir a imagem no ImageJ. 

 

2. Usar o zoom  para aumentar a visualização do papel milimetrado. 

3. Selecionar a ferramenta linha  e medir o papel milimetrado. 

4. Selecionar Analyze > Set Scale... e inserir o valor medido no campo Known 

distance. Inserir a unidade (mm) no campo Unit of length > OK. 

 

5. Selecionar a ferramenta retângulo  e selecionar apenas as esferas de alginato. 

Selecionar Image > Crop para eliminar a parte desnecessária da imagem. 
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6. Selecionar Image > Adjust > Color Threshold para o programa reconhecer as 

esferas. O reconhecimento ocorre automaticamente, apenas feche a janela. 

  

7. Selecionar Analyze > Set Measurements. Selecionar as opções: Area, Mean gray 

value, Standard deviation, e Min & Max gray value > OK. 

8. Selecionar a ferramenta varinha   e clicar duas vezes em cima. Ajustar 

Tolerance para 100 e Mode para Legacy > OK. 
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9. Com a ferramenta varinha  ativada, clicar na primeira esfera. Selecionar Edit > 

Selection > Add to Manager. A esfera aparecerá listada no ROI Manager. Selecionar 

as opções Show All e Labels. Repetir o processo para as outras esferas, individualmente, 

clicando no botão Add do Roi Manager para adicioná-las à lista. Após todas as esferas 

listadas, clicar em Measure no Roi Manager. 

 

10. Salvar a tabela de resultados como um arquivo .csv que pode ser importado para o 

Excel. Também salvar a imagem com as esferas reconhecidas, selecionando a opção 

Flatten no ROI Manager. 
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Material suplementar 3 

 

Medição de tamanho e esfericidade das esferas de alginato no Image J  

 

1. Abrir a imagem no ImageJ. 

 

2. Usar o zoom  para aumentar a visualização do papel milimetrado. 

3. Selecionar a ferramenta linha  e medir o papel milimetrado. 

4. Selecionar Analyze > Set Scale e inserir o valor medido no campo Known distance. 

Inserir a unidade (mm) no campo Unit of length > OK. 

 

5. Selecionar a ferramenta retângulo  e selecionar apenas as esferas de alginato. 

Selecionar Image > Crop para eliminar a parte desnecessária da imagem. 
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6. Selecionar Image > Type > 8-bit para converter a imagem em P&B. 

 

7. Selecionar Image > Adjust > Threshold para o programa reconhecer as esferas. 

Selecionar a opção Auto. 

 

8. Selecionar Analyze > Set Measurements. Selecionar as opções Area, Mean grey 

value, Shape descriptors e Feret’s diameter > OK. 

9. Selecionar Analyze > Analyze Particles, Selecionar Show > Overlays Masks.  
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10. Salvar a tabela de resultados como um arquivo .csv que pode ser importado para o 

Excel. Também salvar a imagem com as esferas reconhecidas. Também salvar todas 

as imagens dos passos 5, 6, 7 e 9. 
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4. CONCLUSÕES GERAIS 

De acordo com os resultados obtidos, conclui-se que: 

• A microalga Nannochloropsis oceanica foi eficiente na remoção de nitrato e 

fosfato em efluente proveniente de sistemas de recirculação; 

• A metodologia de planejamento experimental resultou em esferas de alginato com 

circunferência ideal para a produção das esferas, no entanto, os resultados de 

resistência e densidade não foram satisfatórios, ficando abaixo do predito; 

• A presença de microrganismos naturalmente presentes em efluentes de sistemas 

de recirculação, como diferentes morfotipos de bactérias são um fator crucial na 

estabilidade das esferas; 

• Concentrações de fosfato até 10mg·L-1 não afetaram significativamente a 

estabilidade das esferas. 

• Nannochloropsis oceanica foi mais eficiente na remoção de nitrato e fosfato em 

todos os tratamentos, no entanto, quando comparados, as microalgas imobilizadas 

se saíram melhor que as células livres.  
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5. PERSPECTIVAS DE FUTUROS ESTUDOS 

A partir das hipóteses estudadas e resultados obtidos novos questionamentos surgiram, 

dentre eles: 

• Foram feitas análises somente de nitrato e fosfato, porém outros componentes 

presentes em RAS podem estar afetando o crescimento das microalgas, como por 

exemplo íons de amônia remanescentes dos sistemas;  

• Os experimentos de reforço de banho de CaCl2 podem ser otimizados, diminuindo 

o tempo entre os banhos; 

• Avaliar outros meios de tratamento prévio do efluente antes de expor as esferas 

ao meio, como UV ou ozônio, por exemplo.  

• Realizar a análise completa dos componentes químicos do efluente visando 

identificar os íons que vão competir com o CaCl2 na estabilidade química das 

esferas.  

• A utilização da biomassa produzida pode ser testada para outras aplicações como 

a produção de compostos bioativos, bioenergia e até mesmo alimentação de 

zooplâncton para a aquicultura.  
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